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What CancEGhineseRkeadenPDo?

MDBG Chinese Readscans Chinese text and translates it into Engliskou
move your mousdnstead of opening another window or application, Chinese
w S | RS NI Bivesdanihdow provides immediate reference.

Chapter 1
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Scan the latest news from China, Taiwan or Hong Kong. English translations
are shown immediately as you move your mouse over the Chinese words.
Listen to words pronounced in Mandarin Chinese. Follow along with
phonetics in Pinyin or Bopomofo.

Quickly paste Chinese with English translations into your email or Microsoft
Office documents (Word, Excel, PowerPoint, Outlook, Access)

Easily search popular websites, like Baidu, Google or Wikipedia, using
selected Chinese characters (withoutty@ing Chinese!)

Lookup words in the 82,000+ word Chinese/Piriirglish dictionary. Show
definitions and brief descriptions. Includes proper nouns (popular names,
organizations, government programs).

AL Quickly navigate Chinese websites,
.. " emails, documents, fileseven dialog
boxes with instant translations
K

o o o Do Do

Chinese Reader is designed foryan K SG KSNJ 2 2 dzQNBS | OF adzr £ dzaSNJ 2NJ a2YS2yS

wants to learn Chinese.

A LT e2dz2Q0S S @S NidesstanderteRail @raioeun@it dith R _ ;
/| KAySasSz uUKSy e2dzQff I LIWIINBOAIIUGS K2g [ | (BEEEW | BWEA SNJ O 2
understand Chinese immediately. L

A Enjoy scanning Chinese websitedearn about the latest news and trends? b | .

Chinese Reader is for casual users like you who enjoy seeing the world from o 166 gé 2 3
the Chinese perspective (China, Hong Kong, Taiwan, Singapore, Malaysia). bog phones) | %7 & '
/| KAySaS wSIFRSN) 3AgSa e2dz AyaArA3aKad FyR | ‘y‘f’"""“" 2y Qu 1
Englishbased websites or documents. =R :
A LT 22dzQONB || o0dzaé &a0GdzRSydz &2denétl yi G2 ) e ' KNI &Sz

just irrelevant, meaningless words only used in textbooks. Chinese Reader
provides a rich learning environment for hearing and seeing the words
pronounced. The powerful web links shows you exactly how these words

are used today.

User's Guide

Suggest New Definvtion

Comect Definibion

Chinese Readdeatures quick links to the
online MDBG Dictionary. Suggest new words
and watch the dictionary grow!
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Professional Edition Chapter 1

Educators and corporate users will appreciate the custom featur€hinese

wSF RSNR&a t NP TThia dew oyffiguratiohds allithe feafures of the , ——______>
Standard Edition, plus the ability to personalize and manage words and 5

definitions for an individual , class or workgroup. Riglitk on Chinese o et /4 tum vt/ A 243

characters and enter your own translation and usage nptésFor the first | meamedaka Ry

time, custom English translations and personal notations may be defined by any ® B st

user for any Chinese character or phrasss fast as you move your mou. = il e S ety

With information constantly changing, you need tools to quickly understand the
Asian marketplace and economic trends. Instead of waiting for updates to your e dor e | o
printed or electronic dictionary, the software lets you immediately add new * SOEREEINTS SHFRIerNa
words and definitions . New entries may be added interactively (one woeed at
time) or from a formatted text list. Groups of entries can be selectively enabled
as a resource and shared with other Professional us&rs

Other language learning systems teach Chinese using a limited set of words and .
fixed definitions. Chinese Reader is different. Immerse yourself in what you want " bt ies

to read and let Chinese Reader show you Chistsglish translations through a o

pop-up window. Focus your study only on topics and meanings that are

important to you, your organization or your industry. When study time is
fAYAGSRE / KAySasS wSIRSNDE AylGdAadGAdS (SHOKAy3a adets @ TGS 1y

A As new companies, personalities and political figures become known,
quickly add their names as a nentry

A Tracking Chinese companies and products? Define a custom translation to
include any relevant information (stock symbol, financial statistics, key
contacts and more)

A Save your entries agsourceshat can be shared with others

In the example above, HSBC is added as an entry forinto a new resource

called Business. Based on your selection, the Add Entry dialog suggests Chines
characters, Pinyin and definition and pronunciation. Add complete usage
information, including sample sentences and details about the word or phrase.

A Import resources into a flashcard program for focused study and recall  TheResource Managdets you organize entries into categories (e.g., Business,
Celebrities, Web, Customers). You may enable/disable, delete , import or export
Chinese Reader uses a centralized Chinese/Riyitish resources for both resources.

translations (LiveScan) and lookup (dictionary). In the Professional Edition, add _ _ _
or edit definitions and they are immediately available. For example, adding ~ For more information, see Chapter 10 (Professional Features).

MDBG @GINESIREADER USersGUIDE



Comparing Editions Chapter 1

Professional Edition Standard Edition
Read, understand and learn Chinese
Chinese/Pinyin-English dictionary Over 86,000 entries Same
Instant, pop-up English translations Hover over Chinese for instant Same
English translations
Learn as you use popular applications Web, email, MS Office (Word, Same
Excel, PowerPoint, et al.)
Lookup Chinese/Pinyin or English words Advanced search with wildcards Same
Learn with Chinese flashcard programs Exports to ZDT --
Custom entry/definition
Add new entries (words and phrases) Up to 10,000 --
- Simplified/traditional Chinese characters Yes --
- Pinyin with tone marks/numbers Yes -
- English/Chinese definition Yes -
- Group entries by resource Yes --
Pronounce entries in Mandarin Yes -
Manage resources (groups of entries)
Selectively enable/disable (hide) resources Yes --
Share resources with other Pro users Yes -
Export resources into formatted text file Yes (unlimited) --
Add/edit text file Any text editor --
Import text file into new resource Yes (10,000 entries per resource)
Merge text file into existing resource Yes --
Pricing and upgrades (USD)
Retail price S99 $59
Upgrade to Professional Edition -- S40

MDBG BINESIREADER UsSeErsGUIDE



Easier to Read, Easier to Use Chapter 1

k?’# &Hzﬁﬂ}{ﬁﬁﬁ!@ SZHM ALK S W

Highlightmultiple characters for T 5
A4 Y fast translations in context ustomizethe Livescan.an
48 1k ShEng TS HESEIE iU commmmmmmrmmsey Lookup windows with only the
f‘;-jijll ] ne i [Faverite Word information you need
U dIo wang pou  Faedo yulupu Mngc {Clewr Favorite Words
KFE | ] - ;

AL Show v Simpldes/Traditiaral
da xue shéng . iy g "BEA 7 r,-__
sversity stuiden 9 " [foom ’ v Tone {clors
‘ v Fhomebes
v  Tone Marks

Resize your windownanually or
auto-size to content

Bopomofo

ma shang

t onc ht a . .
a orl e /19 way/ New Features in Version 5.1

2S500S AYO2NLIR NI SR ydzYSNRdza dza SNJ C
latest version. Post your ideas on
http://mdbg.loqu8.com/forums/viewforum.php?f=1

Zoom fonts largeto clearly see the & - i A |
details of Chinese charactersr ‘ A St lined . to feat iall
et & e treamlined menusmprove access to featuregspecially on
displays with loweresolutions
A Tone colorswill help you identify tones aa-glance, Chinese
characters are colecoded to each of the 5 Mandarin tones
Chinese Reader now accommodates a wider range of users and (including neutral). This may be enabled/disabled from the Option
environments. Zoomthe font smaller to minimize the space it takes on your Menu. Choose View>Tone Colors
smaller notebook display or enlarge the font to show details of Chinese A~ Word submenu lets you suggest additions and changes
characters.Pindown the translation window to a corner of your display A HighlightScarcan now be toggled on/off; if you have problems with
(ideal for users with multiple monitors). Size this window or let the program copying text (CteC) in your other applications, turn HighlightScan
auto-size the window based on the content. off from the Option menu, by unhecking HighlightScan

A Clear Favorite Wordkets you clear the list of all the words tagged as
a favorite (yellow star)
Expanded Chinese/Pinyiknglish dictionarynow includes over
82,000 entries, including names of political leaders, entertainers,

The newHighlightScarmode makes it easier to understand several words in
context at one time. Just highlight all the Chinese characters and let Chinese

Reader show you the Pinyin and even read the selection aloud. Select a athletes, companies and consumer products

phrase within the highlight window to see English definitions. HighlightScan is A Performance and compatibilitymprovements have been made in
enabled every time you select multiple characters. To disable this, uncheck the License Manager and with applications developed using Borland
the HighlightScan option. Delphi

MDBG BINESIREADER UsSeErsGUIDE



MDBG Makes Learning Fun Chapter 1

aly&@ LINBPINIYa OFy &K2g &2dz 9y3AtAaK GNIyatldAzyazr odzi F [ 4 da

innovative popup window adds a powerful, interactive dimension to learning. O S
WIS 24-106maFAL %

People learn in many different ways. Some like to understand the rules of
grammar and etymology before attempting to read or speak; there are many
textbooks that are welsuited for them. On the other hand, Chinese Reader is ]
for people whdearn by doing S@Sy AT (KS& gSNByQd LI I yyA
you, then Chinese Reader may be just the tool you need.

LiveScamevolutionizes the way people interact with foreign websites. Instead

of trying to translate the whole page into English (a hopeless, yet comical effort,
gAGK G2RI&Qa GSOKy2t23ASa0x /KAySasS wSI R[S
definitions for each word or phrase in a pop window. You choose the best
translation for the context.

>
Some people can learn Chinese simply by memorizing a dictionary or a list of Learn Chinese using the topics and

10,000 popular characters. You can use Chinese Reatsartoby exploring _ words thatyou want to learn

Chinese websites and instantly viewing English translations. Search for similar Eer
words in the electronic dictionary or search the web for contemporary examples
ofthose wordsusedinredd 2 NI R ySéga adG2Ne 2N of 230 2K ‘ :

Fo2dzi GKS g2NRa &2dZQNB tSENYyAy3d FNBY (2R Jd B6S0aAUSE > k| {@minbi? This NB
about learning Chinese. e ~ -

f M

picture is worth a thousand
words, dollars or more.
Glide your mouse over a picture caption or headline to see the English

definitions, hear the pronunciation and link to websites. Suddenly a powerful :
O2yySOilAz2y Aada YIRS ¢KIi{iQa ¢6KSy fSINyAy3 S G2 G1r1S LxXroSo
R L PR P S e S 2

7 o
Google YRISR! .,,You 47 Gilemtiion
o 8";1\ fIiCkr Bai@.fﬁ \t!;:“:”\ (¢ T

€
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lﬂﬁallaﬂﬁﬁ Chapter 2

» Diwrbandt - Seunty Warnang LB
Do o vt 4o ey & suve Sl $e? MOR) Ot Roader S |55 % Matabing VRGO Onmese Resaw <4 1 -y
D ——1 | ot e Wats 3 | S PPV pp—
3 . a2 v 3 » Bevtoliey MODG Ovineme Ramben i | b7
TEgEe—— . o
Pom mcbulondons | | - Do yes west e rm the seftmwre? St Owwes 175 & May L v manitee. Y Can e pratee s 4m o 9
t2Es Junng ™e

[ Jmre M anos=oae o x
Wisoher mmel I AP BU e 3 [ stame  MOBG Oirvese Bapder 1.1
1 More wohore » ban Dot A I B0t " ahshwlie
Lo I L - = - =
Jeetiading 130 VR TAIME
ClickRunto continue Clickinstall to continue
To install MDBG Chinese Reader: ©)  Alicense key is required to use this product. Fora
’ "r' free trial key, enter your email address below.
1. CI'Ck RuntO dOWﬂload and InSta” Chll’lese Reader WII’]dOWS VISta may aSk By submitting a license key, you agree tc the terms of the Loqui
you verification questions: £ng User License Aqreement.
. i Enter license key or your email address below:
V Do you want to run the file? Cli¢kunbutton
V Do you want to run this application? CliRknbutton

_ Enter your email or license ' [suomit|[cance| | I
V Do you wish to install these components (Simplified Chinese TTS)? Click Y Y |

key and cliclSubmit
Install button i i

V  Vista: When Windows needs your permission to continue installing

Simplified Chinese TTS, cl@bntinue If you are not an administrator,

you will need enter the administrator password and click OK to fi YourRcemse key s expired. Pesformance may be

Contlnue ;v.uC'-a'.f:i '—.’Hr““';.: '::""r"-":- e Al
V Do you want to install this application? Clioktall Click on theBuybutton to 1o the ters's of tre Logus

purchase a license
2. Enter a valid email address into the License Manager. A free trial key will be

sent to your email address from MDBG. The next time you start Chinese SRS bt [ Comtios
Reader, copy the license key from the email and paste it into the License
Manager.
3. After loading and building the database, Chinese Reader will install a small _
icon in your system tray (bottom right corner of your screen). < @m 4:42 PM
4. The MDBG Chinese Reader icon will be installed in your system tray (bottom ] i )
right corner of your screen). MDBG icon installed in your system tray

MDBG BINESIREADER UsSeErsGUIDE



System Requirements Chapter 2

New! Custom Views

MDBG Chinese Reader is optimized for personal computers with Microsoft i i i o i
Windows Vista, Windows XP SP2 or Windows Server 2008. Apple Macintosh Chinese Reader lets you tailor the translation and dictionary windows so they

systems will also require a virtualization environment; see below for details. ~ ©Nly show the information you want.

Minimum

A Chinese fonts (to see and print Chinese characters)

A Simplified Chinese TTS (to hear Chinese pronunciation)

A Microsoft .NET 3.0 framework (included with Windows 7, Vista and XP SP2)

"’ MD8G Chinsse Reader - Scan

=z o
= [=]
romance [ ave (ostwsen man and woman)

25

"" MD8G Chinsse Reader - Scan

Recommended ) o o . ) ) N = E 2] =15 B4 N
t SNE2Y It O2YLIzi SNJ gAUK aAONRBazZTuU 2AyJlse. * e SQa
MicrosoftLilivoice is supported. Internet Explorei8ror Firefox 3 browser. \ | romance / love (between man and woman) i {ostween man and womzn)

Microsoft Office (Outlook, Word, Excel, PowerPoint). Sound card and speakers &\
or headphones required to hear pronunciation.

"" MD8G Chinsse Reader - Scan

=

=

a4 ging2

A Show simplified and traditional ChiNESE | - ore: e oetween mar 3nd wem)
A Show tone numbers or tone marks
A Color characters based upon tone

Virtualization Environments for Mac OS/Linux
A Parallels Desktop

"" MD8G Chinsse Reader - Scan

http://www.parallels.com/en/download/desktop/ A Showrhide phonetics = [-g: ]
A VMware Fusion . _ A Show Bopomofo instead of Pinyin i - R
https://www.vmware.com/tryvmware/login.php?eval=fusion i e eSS ey sl
A VirtualBox — IEIDBG Chinese Reader - Scan
http://www.virtualbox.org/ S ST Z5[E]
7 Wicson o F4(—L2
romance / love (between man and woman)
Not Supported e
Microsoft Windows Me/98/95 Favorite Words
- Shom.. v ; Simplded/ Tracibonal
List an Highlight v Toee Colors
:-:.— i , Tore '/::'i:

Bopamodo

Rightclick on the black title bar and selgctK 2 &e&e Chapter 5 for details.

MDBG BINESIREADER UsSeErsGUIDE



Licensing Chapter 2

Doy Mmool
Trial License eyt vV Resosun
The Chinese Reader software is initially activated for a trial period of 15 days ey e POy Loveican
with complete functionality and full performance. After the trial period, your - i”":" ;“:‘ .
performance will be degraded. At any time, you can restore full functionality by : - |
Arout Help 0

purchasing a license from MDBGhétip://mdbg.logu8.com/buy.htm _

Purchasing a License Ke *
J Y Open theSystem Menuby right

Help support MDBG by purchasing a license key. Major credit cards and bank o .
checks are supported. clicking the MDBG icon

PayPal
visA u

1. To purchase a key, rigltick on the Chinese Reader icon in the system tray.
If Chinese Reader is not currently running, visit f

pour email addieis Lelom

NG 3 Foense hey. pou agree 10 the tenws of the LoguE

Subeil | Canced

http://mdbg.loqu8.com/buy.htmto purchase a license.

2. SelectHelp, thenPurchase Licensé\ new browser window will open up to ‘l‘
PayPal for processing your payment.

Complete the information on the screen.

4. MDBG will send a License Key to your email address. This license is valid
only for one user (per ERdser License Agreement).

To request a trial license key, just enter
your email address and click Submit

w

Entering License Key

If you have purchased a license key, enter it into the License Manager:
1. Rightclickon the Chinese Reader icon in the system tray.

2. SelectHelp,then Activate License Key

3. Inthe License Manager, enter your license key and presEtmierkey. g i ta st 4 ke e Al L s
Chinese Reader will validate your key with the MDBG server. In about a “w.wow Copy and paste thiicense keyfrom
minute, you may resume using Chinese Reader. " the email sent to you by MDBG

e r

MDBG BINESIREADER UsSeErsGUIDE
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Starting Chinesa:Reader Chapter 3

After installing Chinese Reader, the program will automatically load and install
. . . . MDEG
the MDBG icon in the system tray (bottom right corner of your screen). If _ _ _
. . . . & MDEG Chinese Reader v5.1 cnline st
Chinese Reader does not automatically start, click onMiredows Startbutton B8 MDBG Chinese Reader v5.1
and chooseAll ProgramsIn the MDBG folder, sele€thinese Reader v5.1

Click on the WindowStarticon. Choose
AutoStart MDBG thenMDBG Chinese Reader v5

WhenAutoStartis selected, Chinese Reader is loaded every time your computer
starts. See the AutoStart selection in the System Menu (next section). TR
! our Rcerae key has expered, Perfor

Seiracked Heif

purchase a full icense key
Auto Update B Submting 2 fcense key. you 3groe Lo the terms of toe Logt -
If your computer is connected to the Internet when Chinese Reader starts, the |z o @ Chinese Reader
program automatically checks for minor updates. If an update is available, you
will be asked to download the software. CloKto download and install the R - — - | BwY
update. Once Chinese Reader is running you will see a small Chinese Readerican________ ubrelg Contoue -

in the system tray, near the bottom right corner of your screen. o . - - (—— ¥
If your trial license has expired, click

. . Buyto purchase a license. e i =
Expired License Fl—

If your license has expired, you will see a reminder to purchase the software
license. ClicBuyto open a link to the MDBG store. If you have purchased a

license key, enter its value and click®abmit Continuing without a valid S

license will allow the software to continue running, but with degraded =

performance. v MsoStet o e B e e e
LiveScan . [evre=]

Exiting Chinese Reader

To exit the progranyight-clickthe Chinese Reader icon and cho@esefrom
the system menu. To stop Chinese Reader from running every time you start o ‘

Windows, uncheclkutoStart To uninstall Chinese Reader, see Appendix D. q

To close Chinese Readeaght-clickon
the MDBG icon in the system tray

MDBG BINESIREADER UsSeErsGUIDE



System Menu Chapter 3

TheSystem Mentcontrols access to other windows (Scan, Lookup, Favorite
Words) , opens links, displays help and closes the Chinese Reader program.
User Manual

A AutoStartwhen checked, this program will be loaded when Windows is Support Forum | Actoseart

started Check for Dictionary Updates e
A LiveScawindow shows instant Chinese to English translations By bicense ey Leokip
A Lookupwindow allows you to search the Chinese/Pinkinglish dictionary Activate License Key Favorite Words

for words, phrases and names kol Help 5
A Favorite Wordswindowt A & Ga GKS #2NR& GKIFG &2dz2Q@S dGF A3SRAGK &l NI
LiveScan ~ Rightclickon the MDBG icon in i
Chinese Reader continuously scans for Chinese characters near your mouse the system tray

cursor whenever the Chinese Reader icon is displayed. To pause this LiveScan
process|eft-clickthe black/white Chinese Reader icon in the system tray. When
the Chinese Reader icon has turned to gray, then Live Scan is paused. To resume
Live Scan, left click the gray Chinese Reader icon or chowesgcarirom the

System Menu.

< E@\SQS PM

Black/white icon: LiveScan is on
Grayicon: LiveScan is off

< 24 PM

Help
A User Manuat online version of this document
A Support Forunt a community of users moderated by MDBG

A Check for Dictionary Updatesinstalls the latest dictionary Locate theMDBG icorin your system tray, usually

A Buy License Kayopens web page to MDBG Store near the bottom right corner of your screen
A Activate License Kayopens License Manager A Rightclickthe MDBG Chinese Reader icon to op
A About¢ version number, links to support and legal information the System Menu

A Left-clickthe MDBG Chinese Reader icon to turn
LiveScan (translation) mode on or off. The Chine
Reader icon iblack/white when LiveScan is on ar
graywhen LiveScan is off

MDBG BINESIREADER UsSeErsGUIDE



Scan Window and Menus Chapter 3

The Scan yvmdow s.howcases f[he most popular feature of Chinese Reader: oy
instant Chinesdnglish translations. v LiveScan

Translate Page 3
Scan Menu Snapshot

Favorite Words

Rightclickinsidethe Scan window to view these selections:

A Pronounceg speaks the selected Chinese characters in Mandarin
A Copy/Copy entries; copies selection to Windows clipboard

A Lookup ¢ opens the Lookup window (dictionary)

A Other links (Baidu, Bible Gateway, Flickr, et al.) allow you to search the web
using the selected Chinese characters.

List on Highlight
v Show Tone Marks

Show Bopomofo

Size to Content

Zoom 3 & A

Scan Options Menu

% MDBG Chinese Reader - Scan
5 S—— 15557 _
' . . . . ' gido k& i Scan Window
Rightclickthe black title baiof the Scan window to view these options: chocolate - |
A LiveScar toggles instant translations on/off ‘\‘
A Translate Pagg links to Google or Microsoft for web page translations __mm‘\ o
A Snapshot; saves the Scan window into a PNG graphics file Copy CiraC
A Favorite Words; opens the Favorite Words window Copy Entries
A Display settings for Scan window including highlight, tone marks, . e
Pinyin/Bopomofo phonetics, autsizing and font size Viced ,
Search , ._<“‘_| 2aidu .
Glide your mouse over Chinese text to see 5 E: R
instant English translations. B FriencFesd
A Leftclick and drag tdighlight words 2§ CGoogie ’
A Rightclick inside the window to seBcan W Wikipedis
Menu W Yohoo .
A Rightclick the black title bar to open th®can & YouTube
~

Options Menu

MDBG BINESIREADER UsSeErsGUIDE



Lookup Window and Menus Chapter 3

Qx
.Y

/| KAySasS wSIRSNR&a [221dz2lJ A& | LRgSNFdzZ St SOGNRYAO RA dz Ol y
terms in Chinese, Pinyin or English. The Lookup window will display all matches

in the keyword or definition.

Lookup Options Menu

Favorite Words

Lookup Menu Show.. »
Rightclickinsidethe Lookup window to view these selections:
A Pronouncec speaks the selected Chinese characters in Mandarin

A Copy/Copy entries; copies selection to Windows clipboard .

. .
A Lookup ¢ search for the selected Chinese term in Lookup “ =
A Other links (Baidu, Bible Gateway, Flickr, et al.) allow you to search the web EF'

using the selected Chinese characters. :
9 Zhong wén Lookup Window

Chinese / Chinese written language / 1
Chinese writing

AT [ -]

Lookup Options Menu

"™ MDBG Chinese Reader - Lookup

ming li shuang shou N r—

. . . . . . both fame and profit (S5 saw) N, Pronounce Ctrlss
Rightclickthe black title baof the Lookup window to view these options: FYT}] ES) Copy Ctrl+C
A Favorite Words; looks up the words that have been tagged with a star as a Sl [_ ] L y E

favorite word gan dong opy Entries
A to move (sb) / to touch / moving Lookup Ctrl+F

Clear Favorite Words clears the list of words that have been tagged with a TSl IS

yellow star 15# EEE Word ’
A Showc opens submenu with options for displaying simplified/traditional Search

characters, tone colors, phonetics, tone marks and Pinyin/Bopomofo Lookup Menu

A Zoomc enlarge/reduce fonts

From theScan Menwr System Menuchoose

Lookup

A Rightclick inside the window to seeookup
Menu

A Rightclick the black title bar to open the
Lookup OptiondMenu

MDBG BINESIREADER UsSeErsGUIDE



Window Controls Chapter 3

The window controls for Chinese Reader have been significantly upgraded to
give you flexibility to personalize the windows. In earlier versions of Chinese
Reader, the LiveScan window always followed the mouse cursor to provide

instant Chines® y 3t AaK GNI yatlrdAzyae Ly (GKAA GOSNEA2YS &2dz YI& aLAY R2gy¢é GKS
gAYR2g a2 AdQa tSaa RAAGNIOGAY3 F2NJ az2YS dz ° ”CIickthepus#pinto
;g? freezethis window
The resizable windows lets you !
place them in a corner of your ‘ H
desktop and then enlarge ' 8 Click theOto closet_his Wir_1dow ; _
them at your commantd ideal Rightclicktitle bar to see window options, | 1 Chinese Reader will continue to run in
for users with multiple including autesize (size to content) and | 1 the background
displays or highiesolution zoom font size H '
monitors. i i
Classroom instructors (and those who have :I t?\‘ _ l . _
had difficulty discerning the intricacies of "__I: % [% _] Click the star to tag this
Chinese characters) will certainly 7N word as davorite
appreciate the ability to enlarge the fonts : yue shdu
to a very large size. | | instrumental perfarmer Drag the corner of this
window tore-sizelarger or

smaller

MDBG BINESIREADER UsSeErsGUIDE



Quick Thaur

[ SG4Qa GF1S F ljdzA Ol G2dzNJ 2F / KAySas

1. From your web browser, open the website
http://news.google.com/news?ned=cn

2. OntheGoogle Newg Chinapage, you should see something similar to the

image shown to the right. Chinese characters should appear throughout th
page (other than the Google logo, Gmail, etc.).

BO EM SE RA N¥ Gos

COUQI

HERA
WATEFENAALE.

WENARR
! w2

SLTANT | (ERNE
BAPRDALE

TELERER

Shs“a/“! B!Ik? 2R ok

v w-rm».w NESRREITUnE
# ALCEREAEYIERET

L)

"asy
=Ly T

EHMTE,
kit

=

Chapter 4

vSa TSI Hid/NB3 o

SFOAGAVIA

wSlF RSNDA
Seeing Squares?

L &2dzQNB aSSAy3 | f2aG 2F avltft ald:
Chinese fonts and turn on East Asian language support (Windows XP only).
MDBG recommends theR PL New Surig2 y i @ LG Q& 2 LIGA YA
RAGLI @&z O2y il Ayad 020K ¢NIRAGAZ2YIf
FNBES i a5.DQa R2gyft2FIR LI 3ISo

For More Information
DownloadAR PL New Suffiont: http://mdbg.logu8.com/default.htmand see
Appendix B and C for font installation instructions.

MDBG @GINESIREADER
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Suggest/Correct and MDBG Dictionary

Chinese Reader uses the comprehensiveCEDICT dictionary. Through the
efforts of individuals like you, this resource has become an invaluable resource L

Chapter 4

RNEW | B
gUE ]

ahiE
ol oo ge

blog (phonatc

for hundreds of thousands of users. As you use the Chinese Reader software to
read documents, please provide feedback.

A Suggest New Definitiolg Opens the CCEDICT web page for adding a new
entry

A Correct Definitionc Opensthe CC 9 5L/ ¢

S0 LJ 3S

Pronounce

Copy

Ctrl+S

Ctrl+C

Copy Entries

Lookup

Word

Search ’

Ctrl+F

’ Suggest New Definition

Correct Definition

Mandarin pinyin or English definition

By using Chinese Reader, most fields on the page arBlleefor your
convenience. Click the Submit Entry button at the bottom of the page when all
your changes are completed. All entries will be queued for review b@EIRICT
editors. All entries will be licensed under a Creative Commons Attrib&iare
Alike 3.0 License.

MDBG Dictionary

Chinese Reader provides a quick link to the online MDBG website. Select a word
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page.
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Barack Coama (1961-)

Traditional HSK 8
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View definitions, hear pronunciations and more
from the onlineMDBG Chines&nglish Dictionary
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Pronounce, Copy and Lookup Chapter 4

As you glide your mouse over the Chinese characters, the Chinese Reader Scan

window shows: Open theScan Mentby moving your mouse
A Enlarged view of the Chinese character(s) in both Simplified and Traditional pointer into the popup window. Rightlick to
forms. If the web page uses Simplified characters, then Traditional forms (if = 4L HF: @i See a list of actions for the entry
any) are shown in brackets to the rigi{] ARSI TIIRE T
A Phonetic pronunciation (default is Pinyin) % ¥8, M08 Chiiss R Scar : .
A Definition or description in English FAL [HK] @ '?::"""‘"'" :.
z:?shjgne / cellular phone / mobiie p Cogy Entnies
Pop-up Definitions Lookun Cted+F

Just as some English words have multiple meanirgkc6uld mean a color or a

financial loss), some Chinese characters also have multiple meanings and

pronunciations. Chinese Reader groups meanings by pronunciations in the pop 01307 1&RAHERL, THHEER0vi. X5
up window(B].

7l
hé

and / together with / with /sum / union /

Move your mouse pointer into the window and rigtlick to open the Scan
menu to show actions for the current entry :

% MOEG Onieese nader - Loatup Pa
.

beat

peace / harmony / surname He [i] [ﬁ]
A To hear the word pronounced, chooBeonounce Alternatively, you can he ) " — e e ;
cap (a poem) / to respond in singin 4F Hooda Roup
use the shortcut keystroke Gi8. G s

. . : [ it A [ --
A If there are multiple meanings for a word, Chinese Reader lets you select ;cucomp e a setin‘maiong.or playing cards ﬂ P I d! )
and highlight each one by clicking with your mouse. To copy the selected hué Beaf with broccol
entry (or entries), from the right menu choo&wopyor Copy EntriesYou WA PO [ -2
may paste this into an email or word processor document. RS rid 180 chio mian .
A To search the dictionaf{C] for matching words or definitions, choose to mix together / to biend iyt
Lookupor the shortcut, CtrF-. Chinese characters with multiple A4 [ 33!-]
meanings are all shown in the nidrbuldman
Tip: All the functions of the Scan menu (pronounce, copy, lookup, web links) are ndoy Bewns ]

also available in the Lookup window.

UselLookupto search the dictionary using the
selected Chinese character(s) or enter your
own English words

MDBG BINESIREADER UsSeErsGUIDE



Search Web with Google, Wikipedia and More Chapter 4

Web Searches

The Scan menfA] also allows you to conduct web searches at popular
websiteg without copying+pasting or typing Chinese. A new browser window
will open to the specified sitfB].

A Baidu:gateway to Chinese news, web, forum, answers, MP3, images and
video

A Bible Gatewayfind text in Old and New Testament, Chinese Union Version
(Simplified and Traditional) of the Bible

A Flickr. find images on this Yahoo! photo sharing site

A FriendFeedshare a stream of information with your friends

A Google search web, images, news, books, scholar (academic resources) and

Lockup CirisF blogs
Word v | A Wikipedia find articles on specified topic
m) Seach v & Eaidu ’ A YouTube locate videos with selected keyword(s)

v Bible Gatewsy

" Flowr

This concludes the Quick Tour. The following 5 chapters detail the core functions

ﬁ FriencFeed

2§ Coogie . of MDBG Chinese Reader: translation, pronounce, lookup, copy and web
YOII W Wisipede search/link.

¥ Yohoo .

Videos 1
& YouTube
» e Vide .
R

Channels  Playlists == W

T+ AHKE #8 gmeasacobloopers bioopers  gyma

.

Tramsiate resufts info rry Bnguage
_‘w-? T BESE 4 "'1
‘h . RS EREOREN i
9 o LAl
& BV ‘ ) ,

“i« ?‘r&‘: (1]

. ‘nr.‘r_}.‘.u gamnattic [ gyTrentc ]
. Tatsumi FUITTT S Ll Tais OGS | - ; “
RN

0814
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Instant, Rapup Translation Chapter 5

LiveScan, the higbpeed process of translating Chinese into English, is the main
function of Chinese Reader. The latest version of this program incorporates a
powerful new scanning engine that works with a wider range of applications,
including Microsoft Office (Outlook, Word, Excel, PowerPoint) and Mozilla
Firefox.

\ |

‘ The 82,000+ word Chinese Reader
——— ChineseEnglish dictionary is constantly

With LiveScan, Chinese Reader has made Chifiegksh translation faster and _ I e updated. Many wetknown, non
easier. Instead of copying text and pasting it into complicated dialog boxes or "’ | FEE Chinese people, companies, products
requiring users to press cumbersome keystrokes (e.g-RijHt Mouse button), mt: piowmg and organizations are in the dictionary

I KAy SasS wSl imSedaly tfardslatés wadsythe mouse pointer.

¢KS / KAySasS wSlIRSNnDa { Oty @AYR2¢ aKz2gay AR
A Enlarged view of the Chinese character(s) in both Simplified and Traditional S SAHaRa ST
forms. If the web page uses Simplified characters, then Traditional forms (if | RGN T s»vmﬁm ;
any) are shown in brackets to the right * Yol
A Phonetic pronunciation (Chinese Reader of Pinyin or Bopomofo) ﬁ e i ,r_ IF. [3%5-5d]

A Definition or description

Easily read, search and understand the names
The information displayed in the window may be customized to fit your needs. of companies and consumer brands
See Chapter 2 for examples.

With over 82,000 Chinese/Pinyin and English entries in the dictionary, Chinese

wSF RSNJ Aa4 NBFRe (2 KIFEIyRtS (2RIFI&Qa 3INBIFGSad OKI ¢ ﬁhﬁgﬂ‘mﬁfmﬁ;ﬁ;ﬁ;&yﬂmy g &
into English. Multcharacter names of people (Barack Obama) and phrases (food

safety, Frankfurt motor show) have always been a challenge, but not for Chinese
Reader. Unlike traditional dictionaries that are revised annually or less
frequently, Chinese Reader is updated throughout the year for the mosb-up

date names, words and definitions.

Multi-character Chinese words, names
and phrases are parsed into easy
understand English

MDBG BINESIREADER UsSeErsGUIDE



Interactive Translation

The Scan window is amteractive Chinese Reader. Instead of guessing at the
meaning of a word based on frequency or assumed context, Chinese Reader
shows the most common definitions for the word or phrase.

Within the Scan window, definitions are grouped by pronunciation. To guide
users learning Chinese, each definition is also shown with the phonetic (Pinyin
or Bopomofo). When multiple definitions are shown, use your mouse to
highlight and select the entries that are interesting to you. With your mouse,
right-click to open the Scan menu. These options will be explained in the next
chapter.

HighlightScan Mode

2 KSYy tSIFENYyAy3a / KAySasSsz AdQa oSad asSsS GKS
With your mouse, highlight a range of Chinese characters. In the top portion of

0KS 6AYyR2g: &2dzQff aSS |y SytlINHSR @ASs
phonetics. This contextual vig] helps you to focus on each word or phrase

at a time. You may also select a List View to show words/phrases listed one after
another.[B]

Tip: To hear the words spoken in Mandarin, highlight the Chinese (cAGt
select all in the window) and then pre€srl-S

m) =i

¥ MORG Chinose Reader - Scan

KA1 (18 A ]

d quan bl

Rvie SevyToE (on

Co

Sunjem A{mBaER uRs A Mus

Chapter 5

R — 'Es

i [ 58]

ik (9]

R

TheHighlightScarmode helps you focus on selected words.
Get English translations and Chinese pronunciations from
Chinese Reader for selected words in the window.

Y2 NS T U KTy euza U immm—m———y | a

2ZF¥ UKS /&Xéﬁfélgl&&;_[Kj:r?\\/ex\[ 6 RST
8”3‘ Lop g oF]
SRS (Crnina) - 4

B 2

(5574 IR - VAT
|u.: - RTS8 =
: TEHR: RANDSHD. B
fui thtsm A G T HRARF
-I.& e o ”2]115'\,5.},‘“ 7]

PP = =¥ B o i .
to close / to shut iR 1013 o I## ... Navigatinga website? Let Chinese
== i fus Reader give you definitions-at
L
Close a popip  ad?Be sure the BT OBEL A LIRAOMBOBIS . VST (TF0# (TS glance

EAY1l 22dZQNB Of AOLAY Forh foncthbods
really want. Glide your mouse &t -R]

over the text for an instant GF0R, UIERBXING I oo ervores
translation . SRERIEM 1 BEO

i Fastinteractive translationsnakes it
=1 easier for you to scan emails, documents

E, RHERSREL . ENEENEERSE-Sed, sARERESLT gnd presentations for key words

MDBG BINESIREADER UsSeErsGUIDE




Web Page Translation Chapter 5

Chinese Reader now adds the capability to translate an entire web page. From m'w e |

the Scan window, right click the top title bar and chodsanslate PageChoose Timnim L. [ITSEISTISTINISINI (oo sovated s -3 Wl = - .

from Google or Microsoft Windows Live online services. Sy — g

Whole page translation software have been around for decades, but most users %« g % it 3% 7 % ez i i e

FAYR GKSY (22 AylFIOOdzNY S F2NJ Y2A0 dzA . . womrmoins s e v Coe e - s r R asSs8 ATF
for your application. | - v

FRa . sEMPERT R T (5% st e b o # X
|

+ mematoosl tiomtes af 3%

O
R UE VS 6m G5 RS ny\ &Kﬁ w3 [ Fdllﬂ iU 0 2 B o — R TR Vom - Kwong over 1 wed 4
> ; el 2 TS S 2] Chan i Ry TR AT |
B iy M. £8n .‘ Ones TINee IS arc ce
v hgrighticas +[57 9 m Dok an on 0
'

. WFAREE “EAS e

DTR, SN,

|'&= PR, eaE ma | 4ot a3

e ot B! mromard TH

et } 'q ZESHF10%, E-ANAHSDMICISLER. Vot Courtioam W ngpen
WM mHERE REUTE RS ——
' . ") M A SR ATISH L EEE, EANTE H Ba

 BimEnE, BNAEERSENNE—ER, X —

memwm&a

FEASAY ARAN Hens

P [ eesn
RE [ BEER)

Logos and graphics with tex
cannotbe translated

Tip: When the whole page translation software cannot produce a meaningful
translation, it will frequently leave bits of Chinese within the translation. Use

Chinese Reader to instantly translate those words or phrases. Functional Limitations
Chinese Reader is a very powetiit Chinese Reader, but it does not
Close Scan Window understand graphics, videos or animation. Text embedded inside logos,

FROSNIAaAaSYSyida FyR CflakK yAYFGAZ2YyaA
0KS AYRAGARdzZ f / KAyS&aS OKINIOGSNEZ
Websites with complex formatting, may not be currently supported.

At the top right corner, click th®to closethis window . Chinese Reader will
continue to run in the background.

Instant Translation vs. Whole Page Translation
Traditional programs that translate an entire page (or webpageajtahe are ideal for users who just want translations déérag document. This process can
take several minutes per pageSince these programs have a limited understanding of the context, translations can be nonsensical and humorous.

For most applications, Chinese Reader recommends the LiveScan window which translatesteracts/ely. The user is presented with multiple possible
translations and he can choose the appropriate translation for the context. This is especially helpful for navigating \fiel&itg the right tab or closing an
advertisement window). Learning Chinese? Chinese Reader gives you translations only when you need it.

MDBG BINESIREADER UsSeErsGUIDE



Pronungtation andPRhenetics

Chinese Reader pronounces Chinese characters in Mandarin Chinese. Just glide
your mouse over a word or phrase. When the pgpScan window appears,
click inside the window, then rigidlick and choosBronounce(or CtrlS) .

[MD]|Chinese-English
=Y€¢] Dictionary

Chapter 6

A 4 A 2 A = A w 4 LA 1 ﬁ¥ Basic
,2dzQf t KSIFNJ UKS @2A0S Ol NbBTFdzfe Ayuz2yl oS OKigs
E9 s =l=]
TipY LT &2dz R2y Qi KSIN Fy@iKAYy3IxZ 6S adzNB (2 ZF4 'E—’Jdﬁq [ 5]
x4 JIEN d2n
1. From the Vista* Control Panel, selé¢ardware and Sound L Jsirr:)le / not complicated
2. ChooseAdjust system volume BliF—rrororo
3. On theVolume Mixer, look forMDBG Chines&nglishand slide the volume
level up
4. Make sure the channel for Chinese Read@woismuted
5. Close the dialog boxes
* Also seeAppendix B: Windows Vista Tip®or Windows XP users, séppendix
C: Windows XP Tips.
] f 4 Volume Mixer @
Device
‘_ P Device Applications
i g
el Speakers / Chinese-English
Headphones
= =
PH (¢ 4= 7

o [l § @ ¥ 38

¥ =0

=
o
e

B

Pronounce
Copy
Copy Entries
Lookup

Suggest New Word
Correct Word

MDBG Dictionary
Baidu

Bible Gateway
Flickr

FriendFeed
Google

Tudeu
Wikipedia

Yahoo

YouTube

. ;trllS &é 2

Ctri+C

Ctrl+F

Verify that the Speakers/Headphone and MDBG
ChineseEnglish channels areot muted

UsSeErsGUIDE
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Pronunciation

Chinese may be spoken in many regional dialects or variants. Mandarin Chinese
Ad 2FFAOALFE alLkR{Sy ftly3da3asS 2F / KAyl
(Republic of China) and one of four languages of Singapore. Worldwide,
approximately836 million people speak Mandarin Chinese. Standard Mandarin
is based on the Mandarin spoken in Beijing, China. This dialect, used by
iNterpret, is slightly different from the Mandarin spoken in Taiwan.

Standard Mandarin is characterized foyr tones
ACANRBRG (26STa®t PG®RYnn -0
A Second tone (rising): @y é i 6 NAET O B

A Third tone (fallingising): (68 _BT1' =tXA L
A Fourth tone(falling):t &2 10 DAETO {

The neutral tone is shown without any accent markbpgio u i AE1O U U

Tip: Hearing these tones is the best way to learn how to recognize them and to
ALISEHE]1 /T KAYySaSo | as [/ KA-guaclBon wieherrEaND a t
word appears in the Scan or Lookup windows.

Spoken Chinese
Linguists categorize spoken Chinese into 10 different variants. For many
Chinese speakers, each major variant

A Mandarin (including Wu, Jin, Xiardy)
A Cantonese (including Ping)

A Taiwanese (including Min)

A Hakka

A Gan

can be described as a dialect of Chinese. Many Chinese have difficulties
comprehending different major variants. For example, Cantonese is not well
understood by Mandarin speakers. On the other hand, many Cantonese
speakers have learned to understand and speak Mandarin.

6t S2LX SQa

N2

BECDENOEON

w S &

. ‘
SE Hong Kong

S'poken Ch

Mandarin

Wu - 77 million
Cantonese - 71 miliion [worldwide
Min (incl. Taiwanese) - 60 million
Jin {usu. gr
Xiang {conlains V
Hakka - 24 millior

Gan - &7

Hui (ust

inese
vorldwice)

Chapter 6

] KAYL 0SS ¢FAg¢

"9sUB0IT 0T UoNNQUNY SUOWIWOD aAeald 610°anknp o

24
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Customizing Phonetic Views

The Scan popp window may be configured to selective show more or less
information. Righiclick in the Scan window and sel&iiowX

A Simplified/Traditional ¢ check to show both Simplified and Traditional
characters. Urcheck to display only the characters in the text translated by
Chinese Reader.

A Tone Colorg make it even easier to see each of the 4 Standard Mandarin
tones (plus neutral). Check to show Chinese characters in coloaak
to show characters only in black.

0 (4] 1 | % {% . (B

g
ma ma ma

ma | ma
ma / mamma to curse, to revile, to abuse / to scold | interrogative fina! particle

icec name of a river

A Phoneticsc check to display phonetics (Pinyin or Bopomofo)check to
hide this pronunciation help

A Tone Marksc When Phonetics is enabled, shows marks on the Pinyin
phonetics; urcheck will show tone numbers

A Bopomofoc Check to show phonetics with Bopomofo;-aineck to show
Pinyin

Bk T#E | Access control | IR{3%2
! 'ﬁ_’ﬁ‘ MDBG Chinese Reader - Scan X

m| P 7K

fang shui
waterprocf

18 MDBG Chinese Reader - Scan X

B La

R

8 | BHK
» EE P XA”

waterproof

Bopomofophonetics

MDBG BINESIREADER UsSeErsGUIDE

Chapter 6

M8 MDBG Chinese Reader - Scan \ e
215 2] e
Rightclickon thetitle bar to '1‘

B4 —L. . i
remance / lo - SNHOW this Scan Options menu

Check to show
Bopomofo;un-check to
showPinyin phonetics

Chinese Reader uses two different phonetics to guide pronunciation.
Pinyin HanyuPinyin) uses the Latin alphabet (similar to English) to
represent sounds. Some letters (j, qzk) do not correspond to any
English sounds. Pronouncing pinyin according to standard English rules
will frequently be incorrect. Listening to the Chinese pronounced while
observing the pinyin can be very effective.

Chinese Reader uses Pinyin as the default phonetics. Pinyin is very
common in China. In Taiwan, Bopomalbyinfuhao) is more

commonly used. This system uses 37 letters, 21 consonants and 16
vowels, to transcribe Mandarin sounds. Instead of using Latin characters,
Bopomofo uses variations of ancient Chinese characters, simplifications
or nearly identical radicals.

Note: The Pronunciation (shortcut key, C8) is identical for both
Pinyin/Bopomofo and Simplified/Traditional characters. Remember to
click inside the poqup window before pressing Gi8.




Dictionary Ilcookup

Lookup is a powerful tool for finding Chinese words based on:
A Chinese characters

A Pinyin (with or without tone numbers)

A English (e.g., definitions)

A Combination of Chinese/Pinyin and English

With over 82,000 entries , the Chinese Reader dictionary is continuously
updated with contemporary words, names and phrases. Open the Lookup
window from either:

A System menu: rightlick the Chinese Reader icon from the system tray
A Scan menu: rightlick the popup window

Lookup Chinese words from# L
the pop-up windowt
without typing any Chinese

Ui strateg Cow, <t
Copry Entrw
-JJAJO trief
| v AutoStart
LiveScan Jesrcn .
» Lookup
Favorite Words
Help Open the Lookup window from the

System Menwr Scan Menu
Close

1 i

MDBG BINESIREADER

UsSeErsGUIDE

Chapter 7

'™ MDBG Chinese Reader - Lookup

"EREE A
57
zhan lué Search for words in Lookup
”e'ﬂﬁ in Chinese/Pinyin, English
DA PR d or a combination
zhan lué jia
a strategist -
GRBETE .

N B (-5
zhn lué xi ng | Pronounce Ctrl+S Bl e
strategic | dechne (a oftS with Branks

Copy Ctrl+C oiod ok 5 s
ﬂi]. ﬁiﬂ]g Copy Entries 47"1‘.i§‘j [‘giiaﬁg]
di yuan zhan lié Lookip Sl chéng we
geostrategic 15 eapuans thanks
Word ’ \ :
BRI | s : [ )
{ da xw
zhan lié hud ban preys one's tharks
strategic partner o =
2 18 [-38)

e O —
zhan lié yao di
strategic location -

W Tip: To hear all the Chinese words in

Es 1 the list spoken, doublelick theup or

@™ down scroll arrows. To interrupt, press
the Escbutton




Lookup Chinese and Pinyin

Enter theterm you want to find and press the Enter key. Lookup searches the

entire dictionary, bothwords and definitionsdza A y 3 &2 dzNJ G SN¥Y & 2 A (K

multilingual capabilities, you can search for any combination of:
A Chinese traditional or Simplified characters,
A Phonetics Pinyin (with or without tone numbers), and/or

A English with wildcards; seé\dvanced Lookup with Wildcarsection in this
chapter for details

[ 221 dzLIQ &

Favorite Words

Chapter 7

Lookup Options Menu

Show...
I Zoom
Menus i
A Rightclick an entry to open theookupmenu H
A Rightclick the black title bar to open theookup Optionsnenu i
Close Lookup Window wie thanks -
At the top right corner, click th®to closethis window. Chinese Reader will ’“it ="
continue to run in the background. AEEF
"B
"R
A
ma horse
chéng xie
to express thanks
%
15
da xié
Pronounce Ctrl+S to express one's thanks
Copy Ctrl+C igia;—l-
Copy Entries -Fr-——===="" T .. .
i dao xie
Lookup Ctrl+F to express thanks -
- Lookup Window I | 4=
Word »
Search
. Lookup Menu

Click the down arrow to show a
history of past searches in this
session. Presspacebaror
backspaceo edit previous
entries

CtrkS (or doubleclick) on
selected word to hear it
pronounced CtrtA to select
all the words. Press Esc to
cancel

Click the star to tag this word
as afavorite

Drag the corner of this
window tore-sizelarger or
smaller

MDBG BINESIREADER UsSeErsGUIDE



Lookup Names Chapter 7

2KFHGQa &2dN)/ KAySasS yrYSK LT &2dz R2yQd KI @S 2y Learning Chinese in a Modern Context dz:
2yS F2NJ 82dzd a5. DQa O2YLINBKSyargdgsS RAOGAZ2YI NE O
names, inCIUding pOlitiCianS and Celebrities, with a Ch|nese SaUhel name. Tradltlonal Ianguage Classes frequently use
@20 6dzf I NB fAadad { 0dzR
Tip: Select an entry with the name. Type &r{or choos@ronouncefrom the gAff L SOSNI dzaS GKAa ¢
Lookup menu). Hear you name as someone in China might say your name. context, memorizing word lists quickly becomes
a tedious chore.
"™ MDBG Chinese Reader - Lookup 4
5= G Chinese r- 2| < .
- ) | zincld M Chinese Reader helps students learn and
S . [ searcn : discover Chinese through immersion in popular
]y Anud websites. Use Lookup to find words with the
W ERL Arnald (name) / refers to Amcld & X X
My / Ml 2 personis name) Schusareneoger FFS R ST R sl e °|r Cr?.) . i uh a .?ﬁNbJ“]fNJ‘ 8 * )
many popular Chinese dishes with beef.
253 fia R
e goddes fhe Virgin My oot St negger (19473, US ctorand | Visualization is a powerful stimulus. right click
Eé ' ' o politician, governor of Califomia since 2003 Search >Google >Images and students start to
I{%Q PRI recognize their favorite beef dishes and other
T::%qgczl:lzg religious image / figure (of Shi wé xin gé Images tagged Wlth
Confucius, Buddha, Jesus Cl;ris-t_ the '-.-'i;gil'u Wary ;gﬁ%;gé%’;;gge' / also written [EE.5E R
=1c)/ €1 Rlzharng ] e For example, [- ] isHarbin, the
SRl | *’55 é capital of Heilongjiang province in northeast
\‘13’.“ Ifm . El':_ftic:l-?;lilzab:ische.a"r:uu'cher|'puIJIished Ch|na2 I y u U 2 1- Y 2 é é K I U Q é
Maria (name) / St Mary once in 1844 by Ker! Manx and bourgeois Harbin? Click Search >Google >News and see
- | Arnzld Ruge) g
AN o e e recent news stories.
M3 i ya ol - Hin k. -
Aary (biblical name) - BELE . .
&Lb'_ As students interact with webased content,
their interest deepens and Chinese characters
Enter your name in English and let Chinese Reader suddenly come to life like never before.
search for individuals with that name in Chinese CKIGoa KS L2g8SNJ 27F £ S

Reader!

MDBG @GINESIREADER USersGUIDE



Advanced Lookup Chapter 7

/I KAySasS wSIRSNRa [221dzld adzLIl2NLa | gx : f)K OF LJ 67
Far more powerful than any printed or online Chin€seglish dictionary, Lookup }' b 5] ‘
fSGa @2dz GFAf2NI @2dzNJ &S+ NOK gAGK gAfROKNRAE é\% e 2dzQf f ;:A-}f«R____SEI-VGfé gKI G
ﬂﬂ \\ RO Minus €) excludes
Overview /s commonty e nesd \ et SYUGNRSE SAGK
A Entering multiple words and characters impliesAMDfor all terms % \\ e
\

A Use multiple words witlDRto include all matches } \

Al &S ljd2 08 YENL& 040 (2 AyOf dRS t A DElingrelums 228 entries o e

A Use thewildcard(*) at the end of word fragments to match any words that ' fotss
start with that word fragment

A Use theminus(-) to exclude words

Examples

A beijing Finds all 204 entries for Beijing

A" a RdzO{ Adding duck narrows it down to just Peking
Duck

A " ¢capital Shows entries about Beijing, but not about
capital

A " (duck OR university) Only show entries about Beijing duck or Beijing
University

A & O K-éulfat Returns only one entry,

Aaima Returns 4 entries

A ai2 ma Adding the Pinyin tone number 2 #showsai
ma (to receive a scolding)

" ’ | |

ﬁgg{- [_-_?g{_-] Deleting the shows only
jing ai (jing) and words that

respect and love use that character

MDBG BINESIREADER UsSeErsGUIDE



Learning with Lookup

Mandarin uses four tones (plus neutral) to express vowalskupis a handy 5
gl & G2 KSFENJIFYR LINYOGAOS LINRByYy2dzy OAy 3
that share those tones.

iKS

Open Lookup and observe the entries associated with each:

Ama Has about 833 entries (depending on dictionary version)

A mai Has 17 entries including mother and dragonfly

Ama2 Has 100 entries including leprosy and toad

A ma3 Has 670 entries including horse, morphine, mammoth and ant
A ma4 Has 26 entries including curse, mark and headboard

A mas With this neutral tone, has 25 entries including question tag

Tip: Turn onTone ColoréChapter 6) to quickly identify the tones.

Favorite Words

4 82dz 0dzAf R &2dzNJ 920l o0dzAf F NBEZ AdQa
Chinese Reader, just click thiarto the right of each entry. Yellow star means
the word is tagged as a favorite; white star means the word is not tagged.

02y @Sy

To view the list of Favorite Words:
A ChooseFavorite Wordsfrom the System menu, or
A Rightclick the black Lookup title bar and choose Favorite Words

4
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To untag a word as a favorite, click on the yellow star. To clear v AutoStart 7
all the Favorite words, choosglear Favorite Wordsrom the ‘ tivescan  #7
Lookup Options menu. ) lookyp 7
‘ Favorite Words ==}
Help »
Close

1% \DBG Chinese Reader - Lookup

Easily practice your tonesna
with Pronounce(CtrtS)
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Favorite Wordsshows a list of the
words tagged with the yellow star -
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C@W Chapter 8

Copy(CtrtC) copies only the
Chinese characters

After Chinese Reader shows you a translation, you may copy and paste it into
your email, document or other application.

Copy Entriecopies the
selected entries, including
Chinese characters, phonetics
and English translation

Copy copies only the Chinese character(s). For exanjfle:

Copy Entriescopies the highlighted entry (entries) including the Chinese,
phonetics and English translation (per Show settings). For exdBiple - ‘ .

|
2 T WRBMD /WenJiabao(1942), Premier of PRC from 2003/ @ Bew o 3w a0 (), svanter of s fram 300)
[ -1 2 TWBM /WenJiabao(1942), Premier of PRC from 2003/ arx (8wl et AL R 2R TR AL AL T
[ -] Yy ", "7 K /WenJiabao(1942), Premier of PRC from 2003/ . J ——
When multiple definitions for a word are shown, they are grouped by f—
pronunciation. Click to select and highlight an entry. HoldGlrtkey to select il

additional entries. Hold th&hift key to extend the selection range. When all the
entries have been selected, chooSepy Entrieso copy all the entries.
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Tip: In your application (email, word processor), press-Cifbr Edit > Paste) to Modern applications , like Windows Notepad and Microsoft
insert the information copied from Chinese Reader. Not all applications support Office, support Chinese characters, including Bopomofo

Chinese. Paste the information into Notepad. If Chinese appears in Notepad but
not your application, then your application does not support Chinese. T
RELHES . FHRA ., 2RRE. AHEFERUISSREAERS SIS N0TSER
Fhaw A ‘];:‘_‘?lif?}l!v‘ ‘1',1,{» wRamL” ~—[~'31.§ T REL
Most modern appllcatlons (Ilke Windows Notepad and Microsoft Offlce) "'mﬂfﬁfm*nw (Tl 2009 1 B B ESELHARY -
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appear correctly, try formatting them witAR PINewSundont. For Pinyin with
tone marks, usérialfont. To save the file in Notepad, spedifpicode
encoding.
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¥ MDBG Chinese Reader - Scan o
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rich / plentiful

Snapshotsaves the entire LiveScan window,
as a high quality graphics file (PNG)
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Pasting into Microsoft Excel and Word
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Chapter 8

Chinese  Phonetics English Definition
day 2 x @uang very probably, a very good chance (of success)
X @ang to wish for, to desire, to hope
y 1 x §ang hopeful, promising, prospective
~
\\\~\
\\\\
~
\\\ 7 A -~
SSNTipY LT UGUKS tAyeAy R
right, try using a different font,
like Arial

Chinese Reader formats the entries you copy. Each row holds one entry. The Microsoft Word
Chinese characters appear fiI’St, then phonetics and flna”y the Engllsh def|n|t|0rT0 paste just a Chinese Word, press_vtﬂro paste arange of entriesl insert a

When pasting into a spreadsheet or table, the order is preserved:
A Column 1: Chinese characters

A Column 2: Phonetics (Pinyin or Bopomofo)

A Column 3: English definition

Microsoft Excel

table with at least 3 columns and several rows. Highlight all the cells in the table
and press CtV/.

Microsoft Outlook
To paste just a Chinese word, press-EtrTo paste a range of entries, insert a
table with at least 3 columns and several rows. Highlight all the cells in the table

To paste a Chinese word or a range of entries, click on a cell in your spreadshe%?d press CaV.

and press CtV/ . The first column will hold the Chinese characters, the second

holds the Pinyin (or Bopomofo) and the third column holds the English
definition.
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S@ﬁtﬂﬁhﬂﬂ(’t H)WHE b Chapter 9

See an interesting word or name? Riglitk on the Chinese Reader pop

window and search 8 popular web services , like Google, Wikipedia, YouTube N —

and more. One very powerful feature of Chinese Reader is the ability to directly (R MTH XNL WE RRA 9
aSIENOK GKS 6Sod 99Sy AF &2dz KI Sy Qi YIFadSNBR
Chinese, you can still search the web in Chinesihout typing Chinese.
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o Flckr & 3:20 (Chinese Union Version
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53 FrencFeed p
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W Wibpedia
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Search the Bibl€OIld and New
Testaments). In this example,
(xia) is also found in the book of
Genesis, as the name Eve (),
Xiawa.
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Web Services Chapter 9
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Over a dozen web search resources are integrated into Chinese Reader:

7.5 ST
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Want to see video clips of Arnold Fz= | & e

A Baidu:gateway to Chinese news, web, forum, answers, MP3, images and ~ Schwarzenegger O“OUTUbé’ “’ i '

video SRk N

A Bible Gatewayfind text in Old and New Testament, Chinese Union Version.
Chinese Reader augenses the original text as Simplified or Traditional
Chinese and searches the Bible appropriately

A Flickr. find images on this Yahoo! photo sharing site 9 7 - Broazcact Yasromt. - Wrstows braseat Exshare . : T

A FriendFeedshare a stream of information with your friends e il

A Google search web, images, news, books, scholar (academic resources) and -
blOgS Y[)u San vy | Quots

A Wwikipedia find articles on specified topic Home viseos Grannels  Communmy

A YouTube locate videos with selected keyword(s) RXS4" OR WANE' OR TR Ve _ - | Someh I St v

1= voul ube - Srzedcmt Youna# Q= e luae

TPEFROREAFEE ORRE TR OR "FE OR ‘M- WEFROR 'R - WEFH  vourn

Videos Channels Asterence W ' Mgt v

. o A Sagr Mt ez W N N
Even though this YouTube site |sm«w- O . e Trade:d

| KAySasSs I Ny2tR adAatt "KI ayQu f SNy S =

Mandarin Chinese in these video clip g s eml o \:E_
Mo D |51 A2 WA MR Mooy 9
l B schn e 50w SRR TR ermwsia "e

4 & briwret § Pratacned Mude On 1N -
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ProfessionalrEeatures
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THE WAL STREET JMRNAL

o WAL ooem

Maher we / péevious £ to disb / 1o

The Chinese version of the Wall Street Journal

liststhe SEOKIYy3S® / KAYySas wSIRSNDA £ ALSNT
(NI yatl A2y AayQl KSfLFdAx a2 tS5iGQa | RR

abbreviation of theShanghai Stock Exchange
into your personal resource

Rightclick inside the window and

KA a

select Word >Add Resource Entry.

Chapter 10

Dome/ | Canced

Chinese Reader will suggest information
oFaSR dzZl2y (GKS 62NRoaov
Edit the text and click Done to save your

The simplest way to add or edit an entry is to: changes
1. StartMDBG Chinese Reader Professioaatl verify that Live Scan is on.
The Chinese Reader icon should be visible in your system tray. If not, click R
on the gray Chinese Reader icon to toggle LiveScan on BE sonss . sie fase A e
2. Open your website or document. Glide your mouse over the target Chinese soes e
characters. et
3. Single WordRightclick inside the Scan window I S o
Multiple Words highlight all the characters. Click and select all the Chinese Shanghai Stock Exchange (SSE) i (48]
characters (Ct¥R) in the top of the highlight window. Rigtlick inside the composite stock index of 50 Chinese = _;{'L_"__r_“:"l
Highlight window S e Bt Shodk Exhanye 58] v
4. From theWord menu, selectAdd Resource EntryComplete dialog box and s dmrobatelane by ey
click Done fi [-HEZR-)
W) 20ng 2t

Glide your mouse over the Chinese text and see the new definition. To edit the
entry:

1. Glide your mouse over the target Chinese characters
2. Rightclick inside the Scan window

3. From the Scan menu, seléatord > Add Resource EntryComplete dialog
box and click Done

MDBG @GINESIREADER
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Additions and changes are immediately Be companies
updated in both the LiveScan and Lookup

windows.




Example: Adding  for Shanghai Exchange Chapter 10

